
Project Budget 

What is project budgeting? 

 

How to use resources in MS Project? 

 

Risk budget, tolerance budget, change budget 

 

 

 

Project Management 



How the lecture will be conducted?  

1. The lecture is divided into three blocks, where each block introduces 
an issue (1. Project budgeting, 2. MS Project resource, 3. Risk budget, 
tolerance budget, change budget) 

 

2. After each block there is a quiz for feedback on whether you have 
understood everything. 

 

3. We use MS Teams, a shared whiteboard for your engagement and 
reactions. Also we are working with MS Project. 

 

4. The class is supplemented with quizzes in vevox, the link is always in 
the presentation. 

 

 



Contents 

1. PART (30 min.) 

• Project budgeting, theoretical overview. 

 

2. PART (40 min.) 

• MS Project resources (work, cost, material types, asignment of resources, 
reporting, total cost budget). 

 

3. PART (20 min.) 

• Different forms of budget and their importance (cost, change, tolerance).  

 

 

 

 



Learning objectives 

After studying this topic, you should be able to: 

 

• To recognise different types of budgets and cost structures. 

 

• Gain an overview of project cost estimating Methods. 

 

• Using MS Project, you will learn how to create resources in a project. 

 

• Use the knowledge to build a complete project budget and its possible 
methods of creation. 

 

 

 



Key readings 

You can find support in the following sources: 

 

• Book – Chatfield and Johnson (2016). MS Project 2016 Step by Step (Part 5 Set up resource, Part 6 
Assign resources to tasks) 

 

• Book – PMBOK Guide . Chapter 7 (p. 231 Project Cost Management) 

 

 

 

 

 

 

 



PART 1 

 

Project Budgeting 

 

 

 

„Every project, no matter how big 

or small, involves costs.― 

 

• The budget for a project is the combined costs 

of all activities, tasks, and milestones that the 

project must fulfil. In short: it’s the total 

amount of money you’ll need to finish the 

project that should be approved by all the 

stakeholders involved. 

• A meticulously planned project budget is the 

holy grail of the current economy where 

scaling smoothly and sustainably is critical to 

company survival. 

• A project budget is the total estimated cost of 

completing each project activity over each 

phase of a project. It’s important as it helps set 

expenditure expectations and is critical in 

getting project approval, ensuring funds are 

ready at the right time, and measuring 

performance. It’s a dynamic document, 

continuously monitored, reviewed, and 

updated throughout the project 

 



Why a project budget is important? 

• First, it’s an essential part of securing project funding. The 

numbers will tell stakeholders exactly how much money is 

needed to button up the project and when the money is 

needed. 

 

• Second, a well-planned budget provides the basis for 

project cost control. Having an end budget estimate helps 

you measure the project’s actual cost against the approved 

budget and see how much costs you’ve burned already. It 

will give you an understanding of how the project is 

progressing and if any changes need to be made to the plan. 

 

• Third, a project budget has a direct effect on the company's 

financial viability. When calculated feasibly and with 

resource constraints in mind, a project budget will increase 

the operating margin and improve overall project success. 

 



Typical project cost categories 

 Project cost category 
 
 

 
Example 

 
 

Human resources Salary rates of full-time and temporary workers 

Travelling spendings Anyone who travels from one location to another to do 
project work (including budget for meals and lodging) 

Training fees Conferences, workshops, outside contractors 

Material resources All the items your team might need to perform the 
work, including software, equipment, or other unique 
materials 

Research expenses Studies or data to support your project and deliver the 
best value 

Professional services Legal advice, consultants, market research firms, etc. 

Capital expenditures Equipment or technical upgrades to complete the 
project 

Contingency reserves Contingency funds to allow for flexibility and reduce 
risks of budget overruns, usually 5-10% of the budget 

• Planning project costs is an 

essential step in mapping out a 

project budget.  

 

• To do so, you’ll need to create 

a list of timely line items that 

are relevant for the project. 

 

• Some of the costs, such as 

training costs to teach users to 

use a product or maintenance 

costs, are often overlooked by 

managers, so it’s important to 

think ahead if there are costs 

related to the project that will 

come up once it’s complete. 

 



Approaches to estimating a project budget 

• The first type of estimate is an order-of-magnitude analysis, which is made without any detailed 

engineering data. The order-of-magnitude analysis may have an accuracy of 35 percent within the 

scope of the project. This type of estimate may use past experience (not necessarily similar), scale 

factors, parametric curves, or capacity estimates (i.e., $/# of product or $/kW electricity). 

 

• There is the approximate estimate (or top-down estimate), which is also made without detailed 

engineering data, and may be accurate to 15 percent. This type of estimate is prorated from previous 

projects that are similar in scope and capacity, and may be titled as estimating by analogy, parametric 

curves, rule of thumb, and indexed cost of similar activities adjusted for capacity and technology. In 

such a case, the estimator may say that this activity is 50 percent more difficult than a previous (i.e., 

reference) activity and requires 50 percent more time, man-hours, dollars, materials, and so on. 

 

• The definitive estimate, or grassroots build-up estimate, is prepared from well-defined engineering 

data including (as a minimum) vendor quotes, fairly complete plans, specifications, unit prices, and 

estimate to complete. The definitive estimate, also referred to as detailed estimating, has an accuracy 

of 5 percent. 

 



Types of estimates 

• Learning curves are graphical representations of repetitive functions 

in which continuous operations will lead to a reduction in time, 

resources, and money. The theory behind learning curves is usually 

applied to manufacturing operations. 

 

• During competitive bidding, it is important that the type of estimate 

be consistent with the customer’s requirements. For in-house 

projects, the type of estimate can vary over the life cycle of a project: 

– Conceptual stage: Venture guidance or feasibility studies for the 

evaluation of future work. This estimating is often based on minimum-

scope information. 

 

– Planning stage: Estimating for authorization of partial or full funds. 

These estimates are based on preliminary design and scope. 

 

 

 

Classes of estimates 

Source: Kerzner, H. Project Management 



Types of estimates 

 

 

 

Classes of estimates 

Source: Kerzner, H. 2017.  Project Management 

Checklist for work normally required for the various classes (I-VI)  

Source: Kerzner, H. 2017.  Project Management 



Approaches to estimating a project budget 

Bottom-up estimation 

• Rate the individual parts of the 

project plan and tot them up 

• Bottom-up estimation is one of the 

best and fool proof ways to prepare 

a project budget. It anticipates 

estimating individual parts of the 

project, such as tasks, milestones, 

or phases, and totalling them to get 

project cost.  

• This method can be applied if 

you’re at the point of creating a 

statement of work. If you’re sure 

you know every grain of the 

project, bottom-up estimating is the 

way to go. 

The downside of the bottom-up approach is that it takes plenty of time 

to go down to the smallest detail of the project. Additionally, our in-

house research has shown that 71% of tasks are created after the 

project’s start date. In reality, project requirements change even before 

the ink is dry on your statement of work. Also, because it’s very 

granular, at some point you might suffer from inflation affecting the cost 

of your estimates. 



Approaches to estimating a project budget 

Top-down estimation 

• Figure out the total, and then split it into tasks or 

milestones 

• Top-down estimation is opposite to the bottom-up 

approach mentioned above and a completely different ball 

game. It starts with the project budget total and involves 

breaking it down into smaller chunks. Top-down 

estimation is typically used when you have a fixed price 

project with the budget set in stone. 

• The main disadvantage of this approach is loose 

estimations at the project initiation phase. It is difficult 

to accurately predict the budget before you understand the 

scope of work and have a project plan. This process might 

turn very challenging, especially when you can’t measure 

the accuracy of the initial quote against final project 

delivery. 



Approaches to estimating a project budget 

Analogous estimation 

 

• Analyze the data in similar projects to decide the cost. 

 

• If you’re not totally new to project management, you’ve probably managed a few projects before and 

can tell what works and what doesn’t. Using analogous estimation, you would rely on the budget data 

and best practices from your previous projects to form an opinion about how much the current one 

could cost the client. 

 

• Analogous estimation can sometimes be a back-and-forth task, but why not do it the smart way by 

using project management software?  

 

• In Forecast, you can easily duplicate one of the past projects to create another one with the same 

tasks. Then in an instant, you can adjust it to make a better, more situational estimate.  



Approaches to estimating a project budget 

Parametric estimation 

• Using data and project variables to suggest the total 

• In contrast to analogous estimation, parametric approach is more accurate. It takes cost variables or 

data points from specific parts of specific projects and applies them to the current project, so you 

make more decisions based on data. 

• The advantage of this process is that it’s more accurate than the analogous estimation because it 

employs more than one data set and uses the statistical relationship between historical data and 

variables. 

Three-point estimation 

• Take the best, worst, and most likely case estimates to do the average 

• Three-point estimation is one of the most sensible and pragmatic techniques as it takes into account a 

weighted average based on the best, worst, and most likely case budget scenarios and encourages you 

to think from multiple perspectives. Thus you can figure out a realistic cost estimation. 

• The upside of the three-point estimation technique is that you can reduce the risk of going over 

budget, as it will be indicated in your plan, and eventually deliver on expectations. 



How to create a basic project budget in five easy steps 

1. Break down your project into tasks and milestones. Working with your task list will give you an 

understanding of what you’ll need to accomplish and help you with project cost management. If you already 

have a task list, that’s fine, and you can start right off. But if you don’t, start creating a scope and writing 

down everything that your team needs to do. 

2. Estimate each item in the task list. Now it’s time to give each item that you’ve written down an optimistic 

estimation. At this point, identify all the resources and materials you’ll need to perform well and include 

them into your estimate when calculating the price. 

3. Add your estimates together. This is probably one of the easiest parts of the project budgeting process, 

especially if you have a spreadsheet with two columns: Tasks and Costs. Then, you’ll be able to calculate the 

total fast. 

4. Add contingency and taxes. Better safe than sorry. Of course, you can’t be 100% confident about the final 

estimate, as things change all the time. By adding contingency and taxes, you make sure that the project 

doesn’t go over budget and your estimate number is closer to the final costs you eventually spend. If you 

don’t know how much contingency to add, project management experts recommend going for 10% of the 

total. 

5. Get approval. Talking to your manager to approve project costs would be the last thing in the project budget 

creation process.  



A checklist of things to create a project budget 

Make sure you can answer the following questions:  

 

1. Can I define the project and its end goal?  

2. Are there any ground rules, constraints, and assumptions I should consider? 

3. Do I have sources of data (Task List, WBS, Cost Estimates, Schedule) to rely on?  

4. Is the estimating methodology in use acceptable? 

5. Do I know who is going to work on the project?  

6. Do I have a list of resources and their rates to complete the project?  

7. Can I compare my estimate against the best practices industry standard?  

8. Do I have contingency reserves to account for risk?  

9. Who are the key project team members to help me in estimating/budgeting process?  

10. Am I on the same page with Project Stakeholders?  

11. Can I compare the budget with original estimates and reconcile differences? 



Vevox questions 

https://silesianuniversity.vevox.com/#/meeting/449455/polls 



PART 2 

 

MS Project resources 

Using resources in tasks for project 

budget.  

 

• Resources include the people, 

equipment, and material needed to 

complete the work of a project. 

Effective resource management is 

one of the most significant 

advantages of using MS Project. 

 

• You can manage three types of 

resources in Project—work resources 

and two special purpose resources: 

cost and material. Work resources 

include the people and equipment 

needed to complete the tasks in a 

project’s plan. 

 



MS Project set up resources 

• Cost resources represent categories of 

financial costs, derived from specific tasks, 

that you need to account for in the plan. 

• Examples include categories of expenses 

like travel and entertainment.  

 

• Material resources are consumables that 

get used up as the project proceeds. For 

example, a construction project might need 

to track steel or concrete as it is used 

throughout the project. 

 

• Work resources – mainly all people 

involved in project. 

 



MS Project set up resources 

Work resources 

• Work resources are the people and 

equipment doing the work of the project. 

Project focuses on two aspects of work 

resources: their availability and their costs. 

Availability pertains to when specific 

resources can work on tasks and how much 

work those resources can perform. 

 

• A resource might refer to somebody who is 

already on staff, or to a position to be filled 

later. If you have not yet filled all the 

resource positions required, you might not 

have the names of specific people to enter 

 

 

 

To enter work resource names 
1. 1. On the View tab, in the Resource Views group, 

click Resource Sheet to display the Resource 
Sheet view. 

2. Click an empty cell in the Resource Name column. 
3. Enter your resource names, pressing the Enter key 

after each one. 
 
Project applies the default Work resource type in the 
Type field. 



MS Project set up resources 

Work resources 

• Work resources do not have unlimited 

capacity within the limited duration of a plan, 

and Project helps you manage this. The Max. 

Units field represents the maximum capacity 

of a resource to work on the tasks assigned to 

that resource. Specifying that a resource has 

100% maximum units means that 100 percent 

of that resource’s working time is Available  

work on assigned tasks in the plan.  

• Project will alert you with an indicator and 

formatting if you assign the resource to more 

tasks than the resource can accomplish.  

• For example, a resource will be overallocated if it is 

assigned to two or more tasks at 100% capacity each and 

the tasks overlap. 100% is the default Max. Units value 

for new work resources. 

 

 



MS Project set up resources 

Work resources 

• Work resources do not have unlimited 

capacity within the limited duration of a plan, 

and Project helps you manage this. The Max. 

Units field represents the maximum capacity 

of a resource to work on the tasks assigned to 

that resource. Specifying that a resource has 

100% maximum units means that 100 percent 

of that resource’s working time is Available  

work on assigned tasks in the plan.  

• Project will alert you with an indicator and 

formatting if you assign the resource to more 

tasks than the resource can accomplish.  

• For example, a resource will be overallocated if it is 

assigned to two or more tasks at 100% capacity each and 

the tasks overlap. 100% is the default Max. Units value 

for new work resources. 

 

 



MS Project set up resources 

Work resources 

• You can enter pay rates with a variety of time bases—per minute, 

hourly (the default), daily, weekly, monthly, or yearly. You enter rates 

in the format of rate/period—for example, 30/h for $30 per hour. 

Period abbreviations are /m for minutes, /h for hours, /d for day, /w for 

week, /mo for month and /y for year. 

 

• When a work resource has a standard pay rate entered and is assigned 

to a task, Project calculates the cost of the assignment. Project does so 

by multiplying the resource’s assigned work value by his or her pay 

rate—both using a common increment of time (such as hours). You can 

then see the cost per resource, cost per assignment, and cost per task 

(and also costs rolled up to summary tasks and the entire plan). 

 



MS Project set up resources 

Set up cost resources 

• You can use a cost resource to represent a 

financial cost associated with a task in a plan. 

Although work resources (people and 

equipment) can have associated costs (hourly 

rates and fixed costs per assignment), the sole 

purpose of a cost resource is to associate a 

particular type of cost with one or more tasks.  

 

• Common types of cost resources might 

include categories of expenses you want to 

track in a plan for accounting or financial 

reporting purposes, such as travel, 

entertainment, or training. 

• Cost resources do no work and have no effect 

on the scheduling of a task. 

 



MS Project set up resources 

Set up cost resources 

 
To add a cost resource 
 
1. On the View tab, in the Resource Views group, click 

Resource Sheet. 
2.  In the Resource Sheet view, click in the Resource 

Name column where you want to add the cost 
resource. 

3. On the Resource tab, in the Insert group, click Add 
Resources, and then click Cost Resource. Project 
inserts a row for the new cost resource. Project names 
the new cost resource <New Resource>. 

4. With <New Resource > selected, enter the cost 
resource name, and then press Enter. 



MS Project set up resources 

Assign resources to tasks 

• An assignment is the matching of a resource to a task to 

do work. The process of assigning a resource might be 

called a task assignment or a resource assignment, 

depending on the perspective.  

• A task plus a resource equals an assignment. 

• When you assign resources to tasks, you can answer 

questions such as the following:  

– Who should be working on what tasks, and when?  

– Do we have the correct number of resources to 

accomplish the scope of work that our project 

requires?  

– Are we expecting a resource to work on a task at a 

time when that resource will not be available to 

work?  

– Have we assigned a resource to so many tasks that 

we have overallocated the resource? 



MS Project set up resources 

Assign resources to tasks 

• Project calculates work by using this formula: 

Duration  Assignment Units = Work 

 

Here’s a simple example: 

• 40 hours task duration  100% assignment units = 40 hours of 

work 

 

Here’s a slightly more complicated example. 

If you assign two resources to a task that has a 

three-day duration, the result is: 

24 hours (that’s three 8-hour days) task 

duration  200% (for two resources) 

assignment units = 48 hours of total work 

The 48 hours of work is the sum of each of 

the two resources’ 24 hours of work. In other 

words, both resources will work full time on 

the task in parallel for its three-day duration. 



MS Project set up resources 

Assign resources to tasks 

 

• Project management focus: When should effort-driven 

scheduling apply? 

• You should consider the extent to which effort-driven 

scheduling should apply to the tasks in your projects. For 

example, if one resource should take 10 hours to 

complete a task, could 10 resources complete the task in 1 

hour?  

 

• How about 20 resources in 30 minutes? Probably not—

the resources would likely get in each other’s way and 

require additional coordination to complete the task. 

• No single rule exists about when you should apply effort-

driven scheduling and when you should not. As the 

project manager, you should analyze the nature of the 

work required for each task in your project and use your 

best judgment. 

To manage effort-driven scheduling for a 
specific task or tasks 
1. Select the task or tasks you want. 
2. On the Task tab, in the Properties group, click 
Information. 
3. On the Advanced tab of the Task Information 
dialog box, select or clear the 
Effort Driven check box. 
 
To turn on effort-driven scheduling for all new 
tasks in a plan 
1. On the File tab, click Options. 
2. In the Project Options dialog box, click 
Schedule. 
3. Under Scheduling Options For This Project, 
select the New Tasks Are Effort 
Driven check box. 



MS Project set up resources 

The Resource Usage view 

• The Resource Usage view groups the assigned tasks below each resource—this is the same 

assignment information as is shown in the Task Usage view, but grouped by resources rather than 

tasks. 

To check the plan’s costs per task 
1. On the View tab, in the Task Views group, click Other Views, and then click Task 
Sheet. 
2. On the View tab, in the Data group, click Tables, and then click Cost. The Cost 
table appears, replacing the Entry table. 
To check the plan’s costs per resource 
1. On the View tab, in the Resource Views group, click Resource Sheet. 
2. On the View tab, in the Data group, click Tables, and then click Cost. The Cost 
table appears, replacing the Entry table. 
To see resource assignment and other details grouped by task 
1. On the View tab, in the Task Views group, click Task Usage. The Task Usage view 
appears. 
2. On the View tab, in the Data group, click Tables, and then click Summary. The 
Summary table appears, replacing the Entry table. 



MS Project set up resources 

Reports 

• You can use Project reports to see details of 

your plans in a variety of ways. Project includes 

several built-in reports, and you can customize 

those or create your own for the unique 

information needs of your project’s 

stakeholders. 

 

• Some of the useful things you can do are: 

– Create graphical reports within Project 

rather than exporting the Project data to 

another program. 

– Include colorful charts and images, in 

addition to tables, in your reports. 

– Print reports or copy them to other 

programs. 



MS Project set up resources 

Reports 

• You can make different filters in the Report tab 

to show the total budget of the project, you can 

divide the types of resources, you can select 

them according to assignments, tasks, etc.  

 

• You can generate a complex report (also in 

excel) and then work with the budget values.  

 

• Explore the "Report" tab 



Vevox questions 



PART 3 

 

Risk budget, tolerance budget, 

change budget 

 

• Cost risk is one of the most common 

project risks. It can arise from poor 

budget planning and inaccurate cost 

estimation.  

 

• Cost risk is the risk of exceeding the 

budget for a project or failing to deliver 

fair value to offset costs. In addition, you 

may face higher costs due to internal or 

external factors. But what exactly are 

those?  



Risk budget 

• Internal risks occur due to inner actions within the business. For example, 

underestimating the amount of work needed for a project is likely to result in an extended 

schedule, which adds to the project’s cost.  

• The longer the project is, the more it costs. That also means this risk is related to not only 

schedule but also performance and quality.  

 

• External cost risks include risks that occur outside of the business. That may include 

changes to regulations or industry standards, or banking charges. Although you can’t 

control these issues, you can mitigate their impact on your project. 

• The biggest problem with these risks is that you can’t predict their likelihood of 

occurrence. Sub-groups of external cost risks include economic, political, and natural 

risks. 

 

According to PMI’s 2021 study, 38% of projects don’t stay within their planned budget 

range and 35% of projects fail because of a budget loss.  



Risk budget -10 Effective tips to manage project cost risks   

1. Pay attention to the areas where costs may increase (direct, 

indirect, overhead costs) 

2.  Include contingencies in your project budget 

3.  Create a thorough risk management plan 

4. Start a project risk register to track risks 

5. Determine the likelihood and impact of each risk 

6. Outline the Work Breakdown Structure (WBS) 

7. Measure performance with Earned Value Management 

(EVM) 

8. Compare vendors and suppliers for the project 

9. Avoid increasing the scope of the project 

10. Use project management software to monitor costs 



Budget tolerance 

• A budget tolerance is a range within which you can spend without having to report back 

to your sponsor or ask for more money. 

 

• Budget tolerance is particularly useful at the end of a project as you near the delivery date. 

If you have a budget of £80,000 with a tolerance of 10 per cent and you complete the 

project for £85,000 you have still delivered within the parameters set by your sponsor. A 

budget tolerance of 10 per cent means you can deliver the project 10 per cent over cost 

without having to get special permission to do so. 

 

• Tolerance is a range, normally specified as a +/- percentage of total program (or stage) 

budget, which you can spend without needing to return to the steering group to ask for 

further funds. If needed, the contingency budget is always consumed at the end of a 

project (or stage) to ensure successful completion of the program (or stage). You always 

need to seek steering group approval to spend any of the contingency budget. 

 

• NOT A PENNY MORE… 



Change budget 

• If your budget is the roadmap to completing the project, what happens when the 

destination changes? 

• Change orders in projects are the norm, not the exception, so the seasoned project 

manager won’t be stumped by recasting the budget to account for altered objectives. How 

well you can adjust your budget to a scope change depends on how well you budgeted the 

project in the first place. 

• The reason why many teams use earned value management methods is that they give 

accurate performance management information about a project. The metrics integrate 

schedule and budget to provide a rounded way of looking at progress, far more accurate 

than a simple percent complete could ever be. 



Change budget 

Here are four project management events that prompt a change to the budget. 

1. RE-BASELINING IS REQUIRED  - If the scope changes, or the project management 

approach changes during the work, there might be a significant enough impact on the 

performance measurement baseline to warrant a re-forecast of the budget. 

2. SCOPE CHANGES - A change to requirements is very likely to mean a change to the 

budget. The financial impact of the change should be considered as part of the change 

control process. By the time the change is approved, the project team should have a good 

idea of what the difference that will make to the forecasted costs. The easiest thing to do 

when a work package is removed from scope is to adjust the budget down based on the 

budget allocated to that work package. 

3. CONTRACT CHANGES - Contracts may evolve over the life of the project. 

4. CHANGE TO MANAGEMENT RESERVE - The management reserve budget exists to 

address risks and offset the impact of uncertainty. It isn’t there to pad the amount 

allocated to work that was poorly estimated. That said, if management reserves are 

required – for example to fund a period of rework that results from a realized risk – it is 

appropriate to amend the budget. 



Vevox questions 

https://silesianuniversity.vevox.com/#/meeting/449455/polls 



RECAP 

• Make sure you can answer the following questions:  

 

• Can I define the project and its end goal?  

• Are there any ground rules, constraints, and assumptions I should consider? 

• Do I have sources of data (Task List, WBS, Cost Estimates, Schedule) to rely on?  

• Is the estimating methodology in use acceptable? 

• Do I know who is going to work on the project?  

• Do I have a list of resources and their rates to complete the project?  

• Can I compare my estimate against the best practices industry standard?  

• Do I have contingency reserves to account for risk?  

• Who are the key project team members to help me in estimating/budgeting process?  

• Am I on the same page with Project Stakeholders?  

• Can I compare the budget with original estimates and reconcile differences? 



RECAP 

• You need to be clear about how you're going to estimate costs, what 

approach you're going to take. You need to be clear how you can then 

manage the costs. Use of software support helps in planning and managing 

costs.  

 

• Resources include the people, equipment, and material needed to complete 

the work of a project.  

 

• There are other budgets you need to set - risk, tolerance and change budgets. 

 

 

 


